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MS Technology’s SureVistaVision Workstation provides DICOM Imaging Technology that 
makes vital  functions such as viewing,  rendering 2D and 3D images and annotating 
possible  on  any  computer  platform.  Our  powerful  software  accurately  supports  the 
DICOM file formats and is designed to increase productivity.  The Software is created 
with the assistance of radiologists and hospitals across the country.

SureVistaVision  is  compatible  with  any PACS.  It  is  thus  ideal  for  cost  effective  and 
efficient  initiation or  expansion of  your  PACS, workstations  or  teleradiology services. 
First DICOM viewer designed by Radiologists for Radiologist.



DICOM Workstation Features:

Multi-Platform Support (Windows XP, Vista, Mac OS X, LINUX)
Multi Monitor Support
PACS support
Web Integration
Stacking Of Images
Cine
Image Scroll
Contrast/Brightness
Advanced Zoom
Rotate & Flip
Imaging Filters (Edge Detection, Sharpening, Smoothing Images, Haze Removal)
Annotations (Measurement , Angle, SureNote)
Multiple Tools available by Mouse-Click
Thumbnails
Exclusive techniques for 2D
Ultra fast Performance due to unmatched acquisition and processing speeds
Images of importance can be starred and searched
Cross-Reference Lines
Advanced Multi-Planar Reconstruction
Mpeg Video Display
Export Images
Print To Paper
Quick and advanced search
Intuitive interactive user interface
Ideal for any teleradiology applications
Zero Foot print
PACS Compliant

Upgradeable Plugins :

DictaVox Voice recording and transcription
Exclusive techniques for 3D
Molecular Imaging
Pathology
Cardiology
Neurology
Orthopedics
Real time video acquisition
Time lapse image acquisition

_________________________________________________________________________________



Importing DICOM Files

The user can import DICOM files on to system from local workstation or from a local 
area network (LAN). The system supports a variety of DICOM files formats.

Before you can begin importing files, obtain the following information from your system 
administrator:

The names of the files 
The location of the files 
The file formats  

SureVistaVision  supports  files  from following  modalities: CT,  MRI,  X-Ray,  Computed 
Tomography (CR), Nuclear Medicine, RF, OT, DX, MG, Positron Emission Tomography, 
Secondary Capture, DX, Ultrasound (US).

To import a document into the system, select File -> Import. OR click the Import 
button on the toolbar 

The Import window opens. Browse to the folder where DICOM Files are kept in 
the local system or select DICOM DIR.

All DICOM Files will be imported to the viewer and stacked into the work list.

Work list is the database window which shows all information about the DICOM 
files.



__________________________________________________________________________________

Stacking Multiple Patients Data into work list.

 Work list currently displays data in the following columns:
(i.e. Patients Name, Age, Patients ID, Modality, Accession no., Date Acquired & Physician's 
Name)
Each row present in the work list would display study information & on expanding the 
tree we would display all the stacked series present in the study.



__________________________________________________________________________________

Upload button to upload all study files in XML using study path 

When we click on the upload button all the data imported in the list view is uploaded in 
the database (currently written on XML files). Once data is uploaded we can reload that 
data in the list view directly from the database window.
 
Toggle Button to toggle between Database Window & List View.

Search     Search Button to search any data.

Remove     Button removes any series or study stacked in the list view.

Help     Help document has been provided for the user.

__________________________________________________________________________________



Sorting

Sorting data present in work list  by any column, at  study level,  both in ascending & 
descending  order,  by  a  single  click  on  the  column  header  (e.g.  .  "Patient  Name" 
or "Modality" etc...).

__________________________________________________________________________________

Export

User can export DICOM images to JPEG , Tiff, AVI and PDF file formats .

PDA support would be added in later versions of the application.

We can write images on CD/DVD as well.

__________________________________________________________________________________

Image Viewer  
 
The Image Viewer is Synchronized with the study or series selection of the work list 
rows.
 Image Viewer contains 3 components:
 

a) Thumbnails: First Image of each series is displayed with information when Study 
is selected in the work list.  And All images of series are displayed when series is 
selected in the work list .We can drag-drop images from thumbnails to the Image 
View.

 
b) Image View : Displays data based on the selection made in the work list (i.e.

 Displays  image data when series is selected in the work list & Series Data when 
study is selected in  the work list).

  
c) Auto Play: On the Bottom of the Image View is Seek Bar having play button on 

the right corner. On selecting the study in the list view first image of all the series 
is displayed in the thumbnail bar. We can drag any series from the thumbnail on 
to the Image View. The dragged series with all the images present in it is loaded 
in the Image View and auto play is enabled. As we click on the play button all the 
images  of  loaded  series  are  displayed  one  by one  in  sequence with  default 
speed. We can scroll images of series from the image view by using mouse scroll 
button or by moving the marker present on the auto play bar. 

  



__________________________________________________________________________________

Remove

Remove can be used for removing Study or Series from List View.

__________________________________________________________________________________

2D Viewer 
 
To launch 2D Viewer on DICOM Monitor, double click of any study or series present in 
the work list
OR 
Double click on the image present in the Image View.

It would display the Patients Name, Patient ID & Referring Physician's name on 
the viewer window caption.



Scenarios   for launching 2D viewer.

a) If we double click on any study on the list view first series of that study would be 
loaded in the 2D viewer and first image of all the series present in that study will  be 
displayed on thumbnail bar. 
  
b) If we double click on any series in the list view that series would be loaded in 2D 
Viewer and first image of all the series present in the study to which the clicked series 
belongs are displayed on the thumbnail bar.

c) If we double click on the image in the Image Viewer present in the list view, 2D Viewer 
is launched showing first image of the series to which the clicked image belongs & first 
image of all the series present in that study are  displayed on the thumbnail bar. 



Slider control on top of the 2D Viewer for traversing images of selected 
series. 
  
User can scroll through images for traversing images of series or use slider control to 
move to any image of series. The slider would work for the active window ( i.e. active 
study or window).
2D Viewer tiles multiple windows for enabling the doctor to compare different series.  
 _________________________________________________________________________________

Image Processing

Following features of Image Processing are present: 

1) Intensity: (Brightness & Contrast) : Applied by pressing the left mouse button and 
dragging it horizontally or vertically.
2) Edge Detection: Select Edge Detection from the down menu on the image, it is 
undone by reselecting it from the menu. 
3) Sharpness: Select Sharpness from the drop down menu on the image, it is undone 
by reselecting it from the menu. 
4) Smoothness: Select Smoothness from the drop down menu on the image, it is 
undone by reselecting it from the menu. 
5) Initial image: The user can return to initial image after making any no of image 
enhancement operations.



 

All operations are performed for the entire series and would add on to the previous 
operation. (i.e. User can rotate  image then do Edge Detection on rotated Image etc...)

__________________________________________________________________________________

Presets

 We can use Presets  for  CT images.  We are having 4 preset  options in  the popup 
menu on  right  click  of  the  image.  Presets  are  the  predefined  value  of  brightness  & 
contrast on which a particular part of the image gets highlighted. 

CT Brain, CT Bone, CT Abdomen, CT Pulmonary and default WcWw. 



The intensity i.e. a mix of brightness and contrast is set to a pre-defined value where that 
type of image has a best view possible.

__________________________________________________________________________________

Annotating Images.

 
Annotations are  digitized versions of  the  marks  commonly used on documents  in  a 
paper-based environment. For example, Pen, Circle and Text notes. Like their paper-
based counterparts, digitized annotation marks are typically used to prepare documents 
for subsequent handling in a business process. However, digitized annotations provide 
additional benefits that paper-based tools do not.

Digitized  annotations  can  be  added,  moved,  and  deleted  at  will.  The  attributes  of 
digitized annotations (such as color, size, text, and visibility) can be readily modified. 



User can annotate images with following annotations:
 

a)  Pen :  Used for writing some information over the DICOM Image, for example if 
the doctor has diagnosed the DICOM image and he wants to write some 
important information over some portion of the image. 

b) Rectangle : Used for highlighting a particular portion of the DICOM Image. 

c) Circle: Used for highlighting a particular portion of the DICOM Image, for 
example in an X ray highlighting the fractured bone part.

d) Circle: Used for highlighting a particular portion of the DICOM Image, for 
example in an X ray highlighting the fractured bone part.

e) Ruler: Used for measuring the dimension of a particular portion of DICOM Image, 
for example Measurement of Appendix size on an image of intestine. 

f) Arrow: - Used for pointing towards a particular portion of the DICOM Image. For 
example-If there is some text written over the image, arrow can be used to 
indicate to which portion of the image the text belongs. 



g) Sure Note: Used for writing some information regarding a particular portion of an 
image or for the entire image in a separate window which can be invoked by 
double clicking on the sticky note image. The sticky note image appears on that 
part of the image where the sticky note cursor is clicked.

 
h)  Angle:  Used for measuring the Angle of a particular portion on the DICOM 

Image  or Angle between two objects  on the DICOM Image, for example Angle 
between two tumors on the CT scanned image.   

i) Eraser: Used for deleting annotations made on the DICOM Image.
 
    
 
You can also show and hide annotations, select them, change their size and location, 
and delete them.
 
Saving  Annotations.
  
Annotations created on different slides/images of series can be saved by clicking on the 
save button on the toolbar.

Dicta Vox : the user can make audio annotation at image level and refer to them at later 
stage,they can be deleted, played back again and again.
 _________________________________________________________________________________

Flip  We can flip the image in horizontal or vertical direction

__________________________________________________________________________________

Zooming

When  viewing  a  DICOM  file you  can  zoom  in  or  out by  right  click  on  the  image 
and select zoom from drop down menu on the 2D Viewer.  

Hold the left mouse button and drag the mouse upwards to zoom in and downwards to 
zoom out. Image is zoomed in or out by 1 percent.

Zooming Images at series level 

All Images of series can be zoomed up to 5000%. To Zoom In select the Zoom option 
from the right click popup menu on the image in 2D Viewer, the pointer becomes zoom 
icon, hold the left mouse button and drag it upwards.

To Zoom out select the Zoom option from the right click popup menu on the image in 2D 
Viewer,  the  pointer  becomes  zoom  icon,  hold  the  left  mouse  button  and  drag  it 
downwards.

__________________________________________________________________________________



Move

The user can select Move option from the right click menu on the image.

The pointer becomes a move icon, now hold the left mouse button and drag the mouse 
the image will move in the direction the mouse is moved centered at the point where it is 
held. 

__________________________________________________________________________________

Rotate

All Images of series can be rotated at any angle. 
Images can be rotated to any value by dragging mouse horizontally on the image after 
selecting the Rotate option from the right click popup menu. 

__________________________________________________________________________________

Printing
 
The user can print all images of selected series in 2D Viewer.
User can Invert all images while printing, and do multi page printing, with a live preview. 



By selecting the multi pages per sheet option in the Page Scaling we can print 4 images 
on one sheet.

__________________________________________________________________________________

Plug Ins

We have the following plugins available with SureVistaVision:

T2 Fit Map

Invert: We can invert image by selecting Invert option from Tools menu under Plug ins

Orthogonal Re slice

Fill Gaps

__________________________________________________________________________________

 
Invert  We can image by selecting Invert option from Tools menu under Plug-ins.
 
Clear is used to close one instance of 2DViewer while Done is for closing all instances 
together.



Auto Play is same as browse, which can be used to scroll though all the images of the 
series in a frame-by-frame view.
It has three variable speeds to choose from, slow, medium and fast.
There’s option of playing the images in loop OR to and fro motion.
 _________________________________________________________________________________

3D Viewer

3D Viewer can be invoked by clicking on the 3D Options button present on the toolbar of 
2D Viewer. Following 3D options are available.

1) 3-D MIP
2) 3-D MPR
3) Volume Rendering
4) 2-D Orthogonal
5) Surface Rendering

We have the following options when viewing 3D Images

a. Zoom
b. Move
c. Rotate
d. Crop
e. Initial Image
f. Cut
g. Opacity
h. 3-D MIP
i. 3-D MPR
j. Volume Rendering
k. 2-D Orthogonal MPR
l. Surface Rendering
m. Axial View
n. Coronal View
o. Sagittal View







__________________________________________________________________________________

MPEG2
 
Stacking DICOM Files with MPEG2 DICOM Data. 

On Double Click of series in work list MPEG2 Evincere would launch to play the selected 
series (with MPEG2 data).

__________________________________________________________________________________
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